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Introducing CorelDRAW® Technical Suite X7

CorelDRAW® Technical Suite X7 is the complete
solution for visual communication and
technical publication — print, online and to
mobile devices. Industry-leading file
compatibility and precise illustration tools
streamline the workflow of today’s technical
communication professionals and technical
graphics users, simplifying single-source
publishing of standards-compliant technical
publications for a global market.

Corel DESIGNER® X7 is renowned for its
specialized tools and features designed for the

specific tasks required of technical illustrators.
From dimension lines, callouts and annotations
to threads and wells, magnified views,
projected measurements and precise alignment
aids, Corel DESIGNER X7 offers everything you
need to create clear and accurate technical
illustrations. In addition, there are new and
enhanced tools and features that simplify the
creation of high-quality, technical
communication projects, including
sophisticated documentation, detailed
assembly instructions, user and maintenance
manuals, and more.
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Using CorelDRAW Technical Suite X7, you can
access your critical data from various sources
and ensure all of your important technical files
can be delivered in a readable format. You can
take advantage of Lattice3D Studio Corel
Edition to open, edit, and modify 3D models
and import 3D views into your technical
illustrations. This 3D visualization application is
fully integrated with Corel DESIGNER and Corel
PHOTO-PAINT, so you can easily output 3D files
to high-quality vector illustrations and bitmap
renderings. And with 3D visualization
efficiencies, you can insert 3D models as linked
or embedded objects into any technical
illustration for instant access, sharing and
reference. As an optional add-on, Lattice3D
Studio Corel CAD Edition lets you automatically
update 3D-sourced illustrations to implement
manufacturing design changes.

CorelDRAW Technical Suite X7 provides
industry-leading file format compatibility,
which ensures smooth collaboration with
colleagues and clients alike. Whether it's
AutoCAD® DWG® and DXF, Adobe® Illustrator®
CS/CC, Adobe® Photoshop® CS/CC, Microsoft®
Publisher, or Adobe® Acrobat®, you can access
and repurpose data from a wide range of
formats.

Furthering its industry-leading file format
compatibility, CorelDRAW Technical Suite X7
now lets you publish your document as a 3D
PDF. You can export to over 100 file formats —
including CGM, SVG, EPS, DWG, TIFF, PNG,
JPEG — ensuring that you can easily exchange
files with colleagues and clients worldwide and
produce a range of downstream outputs.

If your work is destined for a global audience,
you can easily localize your drawings thanks to
new XLIFF file support, the format used to send
text to, and receive text from, Translation
Memory Systems (TMS). You can also rely on
compliance with various standards-based
systems thanks to support for SVG and CGM,
including WebCGM standards from ATA and
S1000D.

With Corel DESIGNER X7, you'll work more
efficiently and productively thanks to a wide
array of new and enhanced features — from
fills and transparencies to improved multiple
document and automation workflows.

Corel DESIGNER X7 provides a powerful
automation interface, which lets you publish to
SVG as a background task. This also makes it
easy to integrate with Content Management
(CMS), Product Data Management (PDM), and
Product Lifecycle Management Systems (PLM).

CorelDRAW Technical Suite X7 also provides
professional creative design and image editing
applications, such as CorelDRAW® X7 and
Corel® PHOTO-PAINT" X7, which are ideal for
producing downstream outputs from a
technical illustration or imported 3D design,
such as marketing collateral, graphics, and
presentation materials.
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In the interest of user choice, there are several
CorelDRAW Technical Suite purchase options.

Perpetual

* Technical Suite Standard Membership:
Anyone who licenses a box, download or
multi-seat permanent license of the suite is
eligible for this free membership option,
which includes access to performance and
stability updates, as well as access to fonts
and online content and features, such as QR
code validation.

* Technical Suite Premium Membership: This
paid membership option includes access to
exclusive online content, professional fonts,
early access to new features and services as
they become available, and upgrades to the
next major version of the suite for as long as
your Premium membership is active.
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Subscriptions are ideal for companies and
individuals who are on a fixed monthly or
annual software budget, but need the most
up-to-date tools. You can rent the software
for either 30 or 365 days, and you get all the
benefits of the Premium membership,
including complete access to online content,
professional fonts, new features and services
as they become available, and automatic
upgrades to the next major version of the
suite within the subscription term.
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Customer profiles

These users often have formal training in a
technical or graphics field, such as technical
illustration or technical writing. They work in
discrete manufacturing, automotive,
aerospace, high tech and telecommunications,
architectural engineering and construction
(AEC), and apparel industries.

The graphics created by technical illustrators
are used in assembly instructions, user guides,
illustrated parts catalogs (IPCs), maintenance
manuals, schematics, or wiring diagrams. These
documents are output to various media, such
as print, the web, mobile devices, and
interactive electronic technical manuals
(IETMs).

Technical communication professionals need
create to technical publications in multiple
languages for a global customer base. The
ability to work seamlessly with Translation
Memory Systems (TMS) used in the localization
workflow is critical to streamline processes.

In addition, many small to medium-sized
organizations rely on content authoring and
management systems, so they seek solutions
that can be easily integrated.

These users are often self-taught in graphic
design and work in large enterprise
environments, such as manufacturing,
automotive, telecommunication,
pharmaceuticals, chemicals, and energy
industries.

Among their many tasks and responsibilities is
the need to create a variety of graphics,
including diagrams used in presentation
materials, floor plans, schematics, and
marketing materials.

These users may create graphics from scratch
or base them on legacy files. They often work
collaboratively, and the graphics they create
may later be imported for reuse with office-
productivity, diagramming, and desktop-
publishing software.

In a typical organization, there may be many
technical graphics users spread across several
departments. They are not generally required to
use the software daily, and as such, they do not
often get opportunities for extensive training.

They require cost-effective and easy-to-use
solutions that enable them to repurpose legacy
files and 2D CAD data, create basic technical
diagrams, and publish standardized outputs.

X7
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What's included?

» Corel DESIGNER® X7: This specialized
application streamlines the technical graphics
workflow by offering precision vector
drawing, page layout, and diagramming tools
that meet the demands of technical
illustrators and technical graphics users.

* CorelDRAWE® X7: This intuitive vector-
illustration and page-layout application is the
perfect partner for Corel DESIGNER. It offers
technical communication professionals
additional creative graphics and design tools
that are ideal for more artful endeavors, such
as marketing collateral outputs.

* Corel® PHOTO-PAINT™ X7: This professional
image-editing application lets you quickly and
easily retouch and enhance photos for both
technical communication and creative
graphics projects.

» Corel® PowerTRACE® X7: This convenient
utility lets you quickly and accurately convert
bitmaps, such as scanned blueprints, into
editable vector graphics.

* Lattice3D Studio Corel Edition: This 3D
authoring application lets you create vector
illustrations and photo-realistic renderings
from 3D views, including cross sections and
3D element modifications.

 Lattice3D Player: This 3D viewer is integrated
with Corel DESIGNER X7 for the insertion of
3D data assets in technical illustrations. It
provides the ability to modify 3D views and
display modes.

Corel CAPTURE™ X7: This one-click utility lets
you capture images from your computer
screen, which is especially useful for creating
illustrated software documentation, such as
user guides.

Corel® CONNECT™ X7: This full-screen
browser connects you to the suite’s digital
content library, and lets you search your
computer, local network, and online sources
to quickly find the perfect complement for an
illustration. Fully integrated, it is also available
as a docker in Corel DESIGNER, CorelDRAW,
and Corel PHOTO-PAINT.

Corel® Website Creator™: This application
offers a fast and easy way to design, build,
and manage websites.

PhotoZoom Pro 3: This plug-in lets registered
users export and enlarge digital images from
Corel PHOTO-PAINT.

Microsoft® Visual Basic® for Applications 7.1: This
integrated development environment
includes 64-bit support and helps you
streamline your workflow by automating
tasks.

Microsoft® Visual Studio® Tools for Applications 2.0: This
toolset includes the power of the .NET
framework, so you can create time-saving
macros to automate tasks and extend
functionality.

Duplexing wizard: This wizard helps you
optimize your work for two-sided printing.

X7
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Barcode wizard: This wizard lets you
generate bar codes in a wide range of
industry-standard formats.

Bitstream® Font Navigator®: This award-
winning font manager for the Windows®
operating system helps you manage, find,
install, and preview fonts.

More than 4,000 industry-standard
Architectural, Electrical, General, Mechanical,
and Tools symbols

More than 350 templates, including more
than 40 technical ANSI, DIN, and ISO
standard templates

10,000 high-quality clipart and images

1,000 all new professional, high-resolution
digital photos

1,000 OpenType® fonts, including premium
fonts, such as Helvetica®

800 frames and patterns

Online Help files
User Guide (PDF)
Macro Programming Guide (PDF)

Video tutorials

Microsoft® Windows® 8, Microsoft® Windows®
7 (32-bit or 64-bit editions), or Windows® XP
(32-bit edition), all with latest service packs
installed

Intel® Core® 2 or AMD Athlon” 64 or AMD
Opteron

2 GB RAM

1 GB hard disk space (for typical installation
without content)

1280 x 768 or better monitor resolution
Mouse, tablet, or multi-touch screen
DVD drive (required for box installation)
Microsoft® Internet Explorer® 8 or higher

Internet connection required for product
activation (download version), Membership
and Subscription services, installing updates
and access to some features, including the
Content Exchange and QR code tools
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Key features

CorelDRAW Technical Suite X7 is a complete
and cost-effective solution for authoring visual
communications for publishing to print, online,
and mobile devices.

Technical illustrators require specialized tools
designed for very specific tasks. CoreDRAW
Technical Suite X7 provides drawing and
illustration features that help users work with
precision.

New! Parallel Drawing mode: To speed up
the creation of all kinds of technical graphics,
from wiring diagrams to architectural designs,
Corel DESIGNER X7 has added the Parallel
Drawing mode. It allows you to simultaneously
draw multiple parallel curves while controlling
the distance between them. The Parallel
Drawing toolbar lets you set the number of
parallel curves to create and position them with
precision, and preview the curves as you draw
them. In addition, you can create a series of
parallel curves based on an existing curve.

Pasalel Diawang x
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You can draw parallel curves simultaneously.

Give it a try

Drawing parallel curves

1 With drawing open, click the Curve tools
button, and click a curve tool.

2 On the property bar, click the Parallel
Drawing button [ .

The Parallel Drawing toolbar displays.

3 On the Parallel Drawing toolbar, click the
Parallel Lines button .

4 Specify the number of parallel lines to be
added in the Number of lines box.

5 Click the Preview lines button ] to
preview a parallel line while drawing.

6 Specify the distance between the original
line and the parallel line by typing a value
in the Distance box.

7 Draw a curve in the drawing window.

Enhanced! Node editing: The Object
Coordinates docker lets you draw and modify
shapes and lines with precision, and now you
can reposition a node in a curve object by
specifying its coordinate. The live preview in the
drawing window lets you see the effects of
your adjustments.

CoreDRA 7
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New! Outline Position With Corel DESIGNER
X7, the new Outline Position options help you
create objects with more precise sizes. The
Inside outline, Outside outline, and Centered
outline buttons let you specify whether an
outline is positioned inside the object, outside
the object, or an equal combination of both. By
positioning an outline inside an object, you can
more easily create elements in your designs,
such as walls, with specific sizes because the
outline will be rendered within the object’s
original measurements.
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You can you specify whether an outline is
positioned inside the object, outside the object,
or an equal combination of both.

Enhanced! Special characters, symbols, and
glyphs: The revamped Insert Character docker
presents all characters, symbols, and glyphs
associated with a selected font, making it easier
than ever to find these items and then insert
them in your documents. Available in Corel
DESIGNER X7, CorelDRAW X7 and Corel
PHOTO-PAINT X7, the docker includes a
filtering option that lets you display only the
character subsets that you want. For example,
you can choose to display only the numbers or
mathematical symbols for a selected font.

New! Object styles preview: Object styles
save you time because you can edit a style or a
style set once and have the changes applied
instantly throughout a project. For example,
you can define style sets for callouts and
dimension lines, and use the style sets to
consistently format all callouts and dimension

lines in a project. A new pop-up now appears
when you hover over a style in the Object Styles
docker, offering a quick preview of the style
before it's applied.

Object Styles
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You can preview a style before applying it.

Enhanced! Symbol styles options: If a symbol
in your drawing uses styles that differ from
those in its external definition and you break
the link between the symbol and its definition,
you can rename the styles or merge them. You
also have these options when converting a
linked symbol to an object.

Enhanced! Color Styles docker: The Color
Styles docker lets you use styles and color
harmonies to manage colors and quickly
implement project-wide color changes, which
is especially useful for producing iterative
designs and varying graphic outputs. It's now
easier to view, arrange, and edit color styles
and color harmonies. You can now specify the
brightness value for a color, and constrain the
Harmony Editor’s selector ring, which preserves
saturation and hue while you adjust the color.

The Color Styles docker also offers convenient
View Options, including Hint View, which
provides a visual indication of all document
objects that use a specific color style, and Page
Sorter, which displays thumbnails of all pages
in @ multi-page document and previews
changes as you adjust colors. You can also click
View » Page Sorter to access thumbnails of all
pages in a document, with live previews of
changes you make to the document’s color
styles.
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New! QR Codes: With Corel DESIGNER X7,
you can now add scalable QR codes to a
drawing, allowing you to give technicians in
the field the ability to link to online technical
documentation from printed documentation or
machine labels using a smartphone.

The Property Manager docker makes it easy to
customize a QR code, and you can create an
object style that saves a fixed appearance for
the QR code to enable quick and easy reuse.

You can change the shape, outline width,
color, and fill type of the QR code pixels,
change the background color and fill type, and
more. There's also a Validate option, which
analyzes the QR code to ensure it can be read
by QR code readers, smartphones, and
scanners.

New! Corel Equation Editor: You can
manage formulas as editable elements within
technical illustrations using the Corel Equation
Editor. It lets you create and format
mathematical and scientific formulas, and
insert them in a Corel DESIGNER X7 drawing as
scalable text. The Corel Equation Editor also
lets you modify an equation in a drawing or
reuse legacy equations from CorelDRAW (CDR)
files.
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You can create formulas and
insert them in a drawing.

New! Alignment and Dynamic Guides
docker: When creating a design, alignment
and dynamic guides give technical illustrators
speed and precision. Alignment guides help
you position objects more quickly and lay out a
drawing with precision by appearing on the fly
with suggested alignments to existing objects
on your page. Dynamic guides help to align,
draw, and move objects in precise relation to
other objects.

You can use the new Alignment and Dynamic
Guides docker to access and modify the
configuration of these guides more quickly.
With alignment guides, the new Intelligent
Spacing guides make it easier to precisely
position objects with the same spacing as
nearby objects. Plus, the new Intelligent
Dimensioning guides help you scale or rotate
an object in relation to the dimensions or
rotation angle of nearby objects.

You can use alignment quides
to position objects quickly.

Projected drawing: In addition to the ability to
draw in isometric and other projected views,
Corel DESIGNER X7 provides dedicated
Projected Shape tools, which include Thread,
Well, Cylinder, and Prism tools. You can quickly
and easily draw thread and well shapes in
projected space for the creation of bolts, nuts,
well nuts, and more. These shapes are frequent
requirements for detailed technical
illustrations, and are usually not included in
CAD and other 3D source files.

The ability to add this level of detail helps
technical illustrators ensure that their
visualizations are clear, with all required
parameters specified onscreen.

X7
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You can draw in isometric or other parallel
projections from scratch or to add context and
detail to imported 3D views.

Give it a try

Working with threads and wells

1 In Corel DESIGNER X7, click the Thread tool [&].

2 Drag in the drawing window to set the
radius of the shape, then move the pointer
to set the length, and click.

3 On the property bar, specify the distance
between adjacent threads in the Pitch box.

4 In the Distance from start or end boxes,
specify values to set the distance from the
first thread to the start of the object and
the distance from the last thread to the
end of the object.

You can also edit the thread’s radius and
length by dragging either of the blue
control handles.

5 Click the Well [S] tool, hover over the Right
projected side of the box until the center
snap point appears, drag to set the radius
of the well shape, then move the pointer to
set the length, and click.

6 On the property bar, specify the distance
between adjacent threads in the Pitch box.

Most technical illustrations, in 2D or 3D
formats, originate from data created by CAD
engineers. A technical illustrator will often use
multiple applications before finishing a design.
The ability to exchange this information
between applications without losing data is
critical to a technical illustrator’s workflow.

Enhanced! Insert 3D Model: Unique to Corel
DESIGNER X7, when you import 3D models,
you can place them and resize them
interactively similarly to other imported objects,
and combine them with 2D vector illustrations,
text, and images in the same document. Corel
DESIGNER X7 offers you more flexibility when
you insert a 3D model in a drawing. You can
now embed a 3D model (XVL file), which gives
you the option of editing the 3D model within
the Corel DESIGNER (DES) file at any time.
What's more, if you share the file with other
users, they'll be able to work directly with the
embedded 3D model, eliminating the need to
distribute both the DES and external XVL files.
And just as in the previous version, you can link
a 3D model, which automatically updatesitin a
DES file whenever the XVL file is modified in
Lattice3D Studio Corel Edition.

Step-by-step assembly

You can embed or link 3D models in drawings.

Inserting a 3D model

1 With a drawing open, click File » Insert 3D
Model.
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Give it a try

If this menu command is not available, you
must update your installation to include
Lattice3D Player.

2 Locate and open the XVL (*.xv2) file that
you want to insert.

To embed the 3D model, disable the Import
as linked file check box.

3 Drag in the drawing window to insert the
file at the desired size and position.

You can modify the view of the 3D model,
or access stored views and cross-sections
that were created in Lattice3D Studio Corel
Edition.

Technical graphics professionals need to easily
exchange files with colleagues and clients
worldwide. To that end, CorelDRAW Technical
Suite X7 provides industry leading file format
compatibility, including 3D PDF, .DWG,
WebCGM (including S1000D support), SVG,
and more.

New! 3D PDF support: You can publish
technical drawings to 3D PDF from Corel
DESIGNER X7, giving you the power to create
documents that combine text, vector graphics,
images, and embedded 3D models. Using a
PDF reader that supports 3D PDF viewing, such
as Adobe Reader, the end user can interact
with the 3D model. They can intuitively rotate,
move and size it, access assembly and part
structure information, and take a look inside a
3D model by displaying cross-sections.

3D PDF is an excellent cross-media format. In
addition to being ideal for electronic
distribution, it can also be used for print, with
the 3D content being printed in its default
view.

Step-by-step assembly

You can create 3D PDFs.

Give it a try

Publishing to 3D PDF

1 Open the sample file X7-illustrationsample.des.

This file can be found in the sample files,
available for download:
www.coreldraw.com/cdtsx7samples.

The sample file contains an embedded 3D
model.

2 Click File » Publish to PDF

3 In the Publish to PDF dialog box, click
Settings, and choose Acrobat 8.0 or higher
from the Compatibility list box to ensure
that the 3D model is interactive in PDF
readers.

4 In the Publish to PDF dialog box, click Save.

5 In a PDF reader that supports 3D PDF
viewing, such as Adobe Reader, open the
file you created in step 4.

The 3D model can be rotated, panned, and
more.

Enhanced! AutoCAD (DWG/DXF) support:
Corel DESIGNER X7 has an array of intuitive
Dimension tools and features, including the
ability to accurately measure objects and
distances in projected space. Enhanced support
for the AutoCAD Drawing Database (DWG)
format simplifies working with dimension
shapes when you import those files. In addition
to layer structure and hatch fills, Corel
DESIGNER X7 recognizes dimension shapes in
DWG files, allowing you to use the Dimension

Corele[?hﬁéé%‘x7
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http://www.coreldraw.com/cdtsx7samples.

tools to easily change arrowheads on
dimension lines, reposition dimension text, and
update associative dimensions when modifying
a shape. You also have the option of
maintaining the exact look of the dimension
shape, which converts it to curves and text.
And when you export to DWG/DXF, dimension
shapes are editable in CAD applications, such
as AutoCAD or CorelCAD.
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Corel DESIGNER X7 recognizes
dimension shapes in DWG files.

Enhanced! Hotspotting callouts: Corel
DESIGNER X7 provides an array of tools for
creating and modifying callouts. If your
drawings are used in interactive electronic
technical manuals (IETMs), you can now make
those files even more information-rich by
adding hotspots to callout shapes. Then, when
you output a drawing to a CGM v4 file, the
callout is responsive when clicked or hovered
over. Working in the Object Data Manager
docker, you can link a callout shape to a web
page, jump to a section in another file specific
to the callout shape, or display a screentip. For
example, you can link a part in a design to an
online parts catalog, allowing for instant access
to specific, up-to-date information, such as
price and availability.

The Object Data Manager docker also provides
access to the object properties of callout
shapes, which makes it easy to base callout text
on object properties. This means that callouts
created with object metadata are dynamic, and
saves you time from having to update callouts
when you produce iterative modifications of an
illustration.

With Corel DESIGNER X7, you can also draw
linked callouts by snapping the callout
arrowhead to a snap point in an object. Linked,
or “sticky” callouts are attached to the source
object similarly to connector lines. This means
that when you move the source object, the
linked callout moves with it. You can also
specify how the callout behaves when the
source object is moved; for example, the entire
callout moves, or just the leader line moves
while the callout text maintains its position. In
addition, you can break the link at any time.
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You can add hotspots to callout shapes.
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The diagrams, graphics, and illustrations that
are created by technical graphics professionals
are viewed on a number of platforms — print,
the web, online Help systems, and IETMs —
and for a global audience in multiple
languages. Therefore, technical illustrators
require output options that ensure compliance
with multiple standards-based systems,
including TMS, and industry-standards such as
S1000D, PDF/A, and more.

New! TMS support: Corel DESIGNER X7
simplifies the creation of technical
documentation for a global market and
reduces localization costs by offering the ability
to send text to and receive text from a
Translation Memory System (TMS). You can
export text from a drawing to the XML
Localization Interchange file format (XLIFF), the
industry-standard format for sharing
translatable text between a TMS and software.
Then, when you receive the translated text
back, it can be imported into the existing
document, creating a new, language-specific
file with identical content except the translated
text strings. All text in single- or multi-line
annotations, tables, callouts — even artistic
text, isometric text, or text on a curve — can be
exported for translation, all the while
maintaining formatting such as font type,
bolding, italics, and more. You also have the
flexibility to exclude a text object from
translation or to discard any text formatting.
What's more, Corel DESIGNER X7 supports

both XLIFF 1.2 and the new XLIFF 2.0 standard.
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Corel DESIGNER X7 simplifies the creation of
technical documentation for a global market.

Give it a try

Working with translated text

1 Open the sample file X7-illustrationsample.des.

This file can be found in the sample files,
available for download:
www.coreldraw.com/cdtsx7samples.

The sample file contains text.
2 Click File » Import for Translation.

Locate the folder where you want to save
the file that will contain the translated text,
and click Save.

3 In the Open dialog box, choose the file
X7-illustrationsample-EN-DE.xIf, and click
Open.

This XLIFF file contains German translations
of all text objects in the file
X7-illustrationsample.des.

4 Click Open.

The English text is replaced with German
text.

Enhanced! File support: Corel DESIGNER X7
has enhanced support for the latest versions of
two formats widely used in technical
publication, WebCGM and SVG. You can also
work with the most-recent versions of files
from Adobe® Illustrator® (Al), Adobe®
Photoshop® (PSD), and Adobe® Acrobat® (PDF)
products. In total, Corel DESIGNER X7 lets you
import and export more than 100 up-to-date
vector graphics, bitmap image, document and
other data file formats.

X7
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http://www.coreldraw.com/cdtsx7samples.

Technical communication professionals are
always seeking new ways to streamline their
workflow and work faster. CoreDRAW
Technical Suite X7 offers a wide array of time-
saving new and enhanced features.

New! Workspaces: A variety of tailor-made,
workflow-specific workspaces have been
introduced in Corel DESIGNER X7, CorelDRAW X7,
and Corel PHOTO-PAINT X7. We've worked
with experts from a variety of industries who
use the suite routinely to arrange tools and
features in Corel DESIGNER for specific tasks,
such as Diagramming and Technical Illustration.
There are also CoreDRAW and Adobe
lllustrator workspaces, which will help new
users get up to speed within a familiar
environment. Another option for new users is
the Lite workspaces, which provide exploration-
friendly, scaled-down options in the toolboxes
and property bars. And for longtime users,
there’s a Micrografx Designer workspace
containing legacy menu commands and
toolbar settings.

New! Instant customization: The toolbox,
dockers, and property bars contain handy new
Quick customize buttons which will help you
tailor the interface to suit your workflow. These
buttons offer a faster and more convenient way
to add dockers to your workspace, add or
remove tools from the toolbox, and add or
remove items from a property bar.

Property Bar x

@& —/= ¢ Homm M —|v||—m8M |« 0,176 mm

New! Multiple document interface: You can
now work with multiple documents in a tabbed
view, which helps you stay organized and
quickly switch between several active
documents.
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New! High-resolution monitor support:
Corel DESIGNER X7 has been optimized for
high DPI resolutions, ensuring that user
interface elements appear crisp and legible
when displayed on high resolution monitors.
And for those who work with multiple
monitors, you can drag a document out of the
application window and place it within a
second screen, dedicating one monitor to the
illustration and the other to frequently used
dockers and toolbars.
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New! Overflow buttons: For tablet and
mobile device users, new overflow buttons
have been added to the toolbox, property bar,
dockers, and color palettes to indicate the
presence of additional controls that do not fit
within the workspace. You simply click an
overflow button to instantly access the hidden
tools or controls.
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New! Content Exchange: The new Content
Exchange is an online repository that integrates
with Corel CONNECT and the suite’s
applications, making it quick and effortless to
access and share vector fills, bitmap fills, and
fountain fills with a community of other users.
You can instantly set any asset that catches
your eye in the Content Exchange as a favorite,
which is a quick and convenient way to keep a
list of content that you might want to
download later.

Enhanced! Fill tools: In Corel DESIGNER X7,
the new Edit Fill dialog box gives you more
efficient access to all available controls for
Uniform, Fountain, Vector pattern, Bitmap
pattern, Two-color pattern, Texture, PostScript,
and Vector hatch fills. The Edit Fill dialog box
also provides a real-time preview as you make
adjustments.

The new Fill picker makes browsing, searching,
previewing, and selecting fills quick and easy.
The Fill picker also provides access to both
locally stored fills and those available in the
Content Exchange. You can now instantly
create new bitmap pattern and vector pattern
fills from selected objects in your workspace
and share the new fill to the Content
Exchange.

Enhanced! Transparency: You can now apply
transparency to individual color nodes within a
fountain fill, allowing you to adjust an object's
transparency so that all objects beneath it are
partially visible.

In addition, transparency settings have been
added to the Property Manager docker in Corel
DESIGNER X7 (and the Object Properties
docker in CorelDRAW X7), making it faster and
easier to apply and adjust object transparency.
New options help you to quickly specify
whether transparency is applied to an object’s
outline, fill, or both. Plus, you can instantly
save transparency settings as a style to enable
effortless reuse of the effects you use most
often.

Property Manager
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It is faster and easier to apply
and adjust object transparency.

Enhanced! Corel PHOTO-PAINT X7: This
professional image-editing application offers
technical illustrators and technical graphics
users a broad range of professional and
advanced photo-editing tools, which are ideal
for producing high-quality photo-based
technical documentation. Corel PHOTO-PAINT
X7 includes a variety of new tools and creative
options for retouching photos, such as the
Liquid tools, Unsharp Mask Lens, Planar Mask
tool, a series of camera effects, and interactive
brushstroke feathering and transparency.

You can adjust the properties of a group of
objects in a way that is non-destructive to the
individual objects within the group. For
example, you can adjust transparency levels for
the whole group without altering the pixels of
individual objects.

The Smart Carver makes it easy to remove
unwanted areas from a photo and
simultaneously adjust the photo’s aspect ratio.
For example, you might need to define an area
of a photo that you would like to keep or
remove, such as an element that should not be
included in the documentation. The versatile
Object Removal brush lets you choose to paint
either the area of the photo that you want to
preserve or the area that you want to remove.

You can also use the Smart Carver to change a
photo’s aspect ratio without distorting
anything in the photo. For example, if you
want to resize a photo to fit into the dedicated
page layout for your documentation, you can
paint the photo’s subjects and then use the
Smart Carving presets to contract or expand

X7
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the photo’s background vertically and
horizontally.
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The Smart Carver makes it easy to remove unwanted
areas and adjust the photo’s aspect ratio.

A Technical Suite Premium Membership gives
you access to even more tools and features in
Corel PHOTO-PAINT X7, including the ability to
correct perspective distortions in photos that
have straight lines and flat surfaces such as
architectural photos and photos of buildings.

What's more, Technical Suite Premium
Membership offers AfterShot, CorelDRAW
Edition, a RAW converter, non-destructive
photo editor and high-speed photo manager in
one. It gives you the tools to control every
aspect of your photo workflow whether you are
making detailed adjustments to a single photo
or batch processing multiple RAW images.

You can easily straighten images that were
scanned or photographed at an angle.
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Advanced 3D CAD repurposing

Lattice3D Studio CAD Corel® Edition (optional add-on)

For organizations that require additional 3D
editing capabilities and direct access to 3D CAD
assembly files, CorelDRAW Technical Suite X7
offers an upgrade to Lattice3D Studio CAD
Corel Edition. This upgrade provides native
assembly and part file support for 3D CAD
systems used in discrete manufacturing, such
as the automotive, aerospace, and machinery
industries. Lattice3D Studio CAD Corel Edition
lets users do more with CAD files without the
steep learning curve.

Lattice3D Studio CAD streamlines the workflow
of technical communication professionals by
reducing the need to consult design engineers
when preparing graphics content. It supports a
broad range of native 3D CAD file formats,
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such as assembly and part files from CATIA,
SolidWorks, PTC Creo Parametric (formerly Pro/
ENGINEER), Autodesk Inventor, NX, SolidEdge,
and more. It also supports 3D CAD exchange
formats, such as JT, IGES, STEP, and Parasolid.

Update / replace assembly functionality:
Once a design moves to the production phase,
construction changes are common. With
Lattice3D Studio CAD, you can update early
designs at any time due to changes determined
by construction. Disassembly views,
animations, and other 3D authoring functions
are maintained, so that you can efficiently
update technical illustrations with the most
current revision of the manufacturing design.
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The update or replace assembly functionality offered by Lattice3D Studio CAD Corel Edlition helps you ensure
that the most current manufacturing revisions are reflected at any time in the visualization workflow.

CoreDRAW

s Corel DESIGNER

Reviewer’s Guide [ 19 ]



New! Update a 3D-sourced illustration: To
speed up technical-publication authoring,
CorelDRAW Technical Suite X7 with Lattice3D
Studio CAD Corel Edition offers the Auto
Detection and Update command. It updates
3D visualizations created in Lattice3D Studio
CAD, storing snapshots, cross-sections and
animated procedures — including process
animations for illustrating complex, multi-step
assembly, disassembly, or maintenance
procedures — based on the modifications
applied to the CAD source data. It also lets you
automatically generate updated vector
illustrations to replace ones in DES files that
were created using the Send to Corel
DESIGNER command. The illustration
specifications, such as view, positions of the
objects, line weights and export settings, are
fully recognized and maintained. As a result,
the illustrations are recreated using the
updated 3D model and inserted in the same
place as the original, allowing technical
illustrators to start a publication with a
preliminary 3D design and update it with the
final design instantly.

You can automatically update 3D illustrations.

Give it a try

Updating a 3D-sourced illustration

To try this feature, Lattice3D Studio CAD
Corel Edition is required. The trial version of
CorelIDRAW Technical Suite X7 includes
Lattice3D Studio CAD Corel Edition (30-day
trial).

1 In Lattice3D Studio CAD, open the sample
file 3D-assembly-v1.xv2.

This file can be found in the sample files,
available for download:
www.coreldraw.com/cdtsx7samples.

2 Click File » Send to Corel DESIGNER.

3 In the Send to Corel DESIGNER dialog box,
make sure the Add snapshot check box is
enabled, and click Send.

In Corel DESIGNER X7, the 3D illustration is
inserted in the active page. If the
application is not running, it will launch
automatically.

4 Click File » Save.

5 In Lattice3D Studio CAD, save 3D-assembly-
v1.xv2.

6 Open the sample file 3D-assembly-v2.xv2.

This file contains a modified version of the
3D model.

7 Click File » Auto Detection and Update.

8 In the Auto Detection and Update dialog
box, choose the file 3D-assembly-v1.xv2 in
the Edited XVL box.

9 Click OK to all warning messages that
appear.

10 In Lattice3D Studio CAD, click the Apply
and Execute button.

11 In the Auto Detection and Update dialog
box, enable the Update Illustration in Corel
DESIGNER check box, and click OK.

The 3D illustration is updated in the DES
file.
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Evaluation tools: Before 3D models and data
can be used in downstream applications, the
integrity of the 3D model requires validation.
Lattice3D Studio CAD provides assembly
evaluation tools for geometry and
measurements, interference check, and
collision detection so you can quickly verify the
integrity of a 3D assembly.

Measurement
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Additional 3D CAD tools: With Lattice3D
Studio CAD, you can edit 3D models and
combine 3D models from different CAD
sources. It provides a rich 3D CAD toolset that
lets you modify and transform 3D parts,
shapes, and assemblies.

Animation tool set: Lattice3D Studio CAD
provides a full set of animation tools, including
a dedicated editing console as well as a
method for automated creation of disassembly
animations. Process animations can be created
to capture complex, multi-step assembly or
maintenance procedures with detailed
instructions. The hierarchical structure of the
Assembly Tree view and the ability to create
custom tree structures for disassembly and
process animations gives you full control over
the creation of assembly, sub-assembly, and
part structures for use in illustrated assembly
and maintenance instructions.
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Online and mobile outputs: Lattice3D Studio
CAD supports output of 3D models to HTML5
and for mobile devices. By using the highly
compressed XVL® file format, you can share
complex models with virtually anyone, using
the free Lattice3D Player as browser plug-in for
desktop/laptop or iXVL apps for iOS. XVL is the
most lightweight 3D format in the industry,
enabling data to be compressed to an average
0.5% of its original size with high accuracy. For
example, a 500 MB 3D CAD assembly file can
be shared on mobile devices as an XVL file with
an approximate file size of 2.5 MB.

3D outputs: With Lattice3D Studio CAD Corel
Edition, you can output to various 3D file
formats, including 3DS, DXF, IGES, OBJ, STL,
U3D, and VRML. You can also publish directly
to 3D PDF from Lattice3D Studio CAD Corel
Edition, using a PDF template with animation
controls.
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About Corel

Corel is one of the world’s top software companies providing some of the industry’s best-known
graphics, productivity and digital media products. Boasting the most comprehensive portfolio of
innovative software, we've built a reputation for delivering solutions that are easy to learn and use,
helping people achieve new levels of creativity and productivity. The industry has responded with
hundreds of awards for innovation, design, and value.

Used by millions of people around the world, our product lines include CorelDRAW® Graphics Suite,
CorelDRAW® Technical Suite, CorelCAD , Corel® Painter®, Corel® PaintShop® Pro,

Corel® VideoStudio®, and Corel® WordPerfect® Office. For more information on Corel, please visit
www.corel.com.

Copyright © 2015 Corel Corporation. All rights reserved.
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INFORMATION IS PROVIDED BY COREL ON AN “AS IS” BASIS, WITHOUT ANY OTHER WARRANTIES OR CONDITIONS, EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, WARRANTIES OF MERCHANTABLE QUALITY, SATISFACTORY QUALITY, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE, OR THOSE ARISING BY LAW, STATUTE, USAGE OF TRADE, COURSE OF DEALING OR OTHERWISE. THE
ENTIRE RISK AS TO THE RESULTS OF THE INFORMATION PROVIDED OR ITS USE IS ASSUMED BY YOU. COREL SHALL HAVE NO LIABILITY TO
YOU OR ANY OTHER PERSON OR ENTITY FOR ANY INDIRECT, INCIDENTAL, SPECIAL, OR CONSEQUENTIAL DAMAGES WHATSOEVER,
INCLUDING, BUT NOT LIMITED TO, LOSS OF REVENUE OR PROFIT, LOST OR DAMAGED DATA OR OTHER COMMERCIAL OR ECONOMIC
LOSS, EVEN IF COREL HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR THEY ARE FORESEEABLE. COREL IS ALSO NOT
LIABLE FOR ANY CLAIMS MADE BY ANY THIRD PARTY. COREL'S MAXIMUM AGGREGATE LIABILITY TO YOU SHALL NOT EXCEED THE
COSTS PAID BY YOU TO PURCHASE THE MATERIALS. SOME STATES/COUNTRIES DO NOT ALLOW EXCLUSIONS OR LIMITATIONS OF
LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, SO THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU.
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